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About the Graphical Mode Examples
Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module
(DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files
(*.tcu).

Also search the online help for "Opening Graphical Mode Project Files", which is in
the Thermo-Calc User Guide.

This guide includes the example descriptions and information about how to open a Graphical
Mode project file.

Watch the Video Tutorials
Many of the Graphical Mode examples have video tutorials available both on our website and
our YouTube channel.

You can go to the video tutorials when in Thermo-Calc: Help → Video Tutorials.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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Opening a Project File
To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA)
and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.

2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode button.

3. From the main menu, select File → or Help → Examples Files.

4. The examples are divided into folders. Navigate to the folder and project file you want
and double-click to open.

5. The Graphical Mode examples are stored without calculated results so you will want to
run the example calculation and generate a plot or table. To do this, click the first node
in the tree at the top of the Project window. Then right-click and select Perform now.

Some add-on module examples require additional licenses to run for more than
three elements.
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Thermo-Calc Graphical Mode Examples
This guide includes descriptions of the following examples.

Category Example number

Thermo-Calc including binary and ternary system
examples, Scheil, the Equilibrium Calculator, plus more

T_01 to T_09

Property Model Calculator Examples: General and Steel
models

General models: PM_G_01
to PM_G_03

Steel models: PM_Fe_01 to
PM_Fe_03

Diffusion Calculator Examples

D_01, D_02, D_03 (the
Quick Start Guide Examples)

D_04 to D_07

Precipitation Calculator Examples P_01 to P_11
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T_01: Calculating a Single-Point Equilibrium

This example shows the result from a single-point equilibrium calculation in the Fe-C system. It
demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the
Results window. The number of equilibrium conditions is C+2 where C is the number of
components, meaning that four conditions are needed in this example:

l Temperature is 1000 K

l Pressure is 101325 Pa

l System size is 1 mole

l Mass percent carbon is 0.1%

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_01_Single-point_equilibrium.tcu

l This example is included in the tutorial on our website and YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/3j4xQYdS_TM
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TABLE RESULT

The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases
are stable for this set of equilibrium conditions.
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T_02: Stepping in Temperature in the Fe-C System

This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy when
the temperature is varied between 500 and 2000 K. It demonstrates the use of the Equilibrium
Calculator. To allow temperature to vary, the corresponding Axis Definition check box is
selected.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_02_Step_in_temperature_in_Fe-C.tcu

l This example is included in the tutorial on our website and YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/_BlSlWxeF_g
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PLOT RESULT

In this example, results are displayed graphically using a Plot Renderer activity.

If you want, you can use a Table Renderer to generate text results instead, as shown in this
example after adding a Table Renderer to the Equilibrium Calculator and clicking Perform.
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T_03: Fe-C Phase Diagrams

This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase is
entered in the calculation). The same diagram is calculated using the Binary Calculator activity
and then using a System Definer and Equilibrium Calculator.

In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator is
to simplify common calculations for binary systems. In the Equilibrium Calculator two axes are
defined:Mass percent C and Temperature. An axis variable must also be an equilibrium
condition.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_03_Fe-C_phase_diagram.tcu

l This example is included in the tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/hbhWAUwydDg
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PLOT RESULTS

Equilibrium Calculator Results

This shows the plot result of the System Definer and Equilibrium Calculator system.
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Binary Calculator Results

T_04: Fe-Cr-C Ternary Phase Diagram at 1000 K

This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to
example T_03: Fe-C Phase Diagrams, the same diagram is calculated using a Ternary
Calculator and then using a System Definer and Equilibrium Calculator. Two Plot Renderer
activities are added to create two plots.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_04_Fe-Cr-C_ternary_phase_diagram.tcu

l This example is included in the tutorial on our website and YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/sqfhr9sNwfQ
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PLOT RESULTS

Ternary Calculator
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Equilibrium Calculator

Try practicing with two features on the Plot Renderer Configuration window. To
toggle between a triangular and a rectangular diagram, click the Show Triangular
button then click Perform to see what happens. To toggle the X and Y axis
variables, click the Switch Axes button and then click Perform.



Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 13 of 98

T_05: Stable and the Metastable Fe-C Phase Diagrams

This example shows how to overlay results from two calculations in the same plot using the
Equilibrium Calculator.

1. The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1.

2. Then right-click the Plot Renderer node and select Add predecessor and the results
from both equilibrium calculators are in the same plot. In Equilibrium Calculator 1 the
stable phase diagram is calculated and in Equilibrium Calculator 2 the metastable phase.

3. The metastable diagram is obtained by deselecting the graphite phase on System
Definer2 → Phases and phase constitution tab.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_05_Fe-C_stable_and_metastable_phase_diagram.tcu
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PLOT RESULT

T_06: Serially Coupled Equilibrium Calculators

Sometimes there are multiple solutions for a given set of equilibrium conditions. In other cases
the equilibrium calculation does not converge. You can then aid the final calculation by, in
effect, telling the software where it should start the search for the equilibrium.

This example shows how to serially couple two Equilibrium Calculator nodes together for more
complex equilibrium conditions. For each calculation, the output is to a Table Renderer.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_06_Serial_equilibrium_calculators.tcu

Table Renderer Results

Equilibrium Calculator 1

In the first example, the objective is to calculate the equilibrium at 850° C where the mole
fractions of the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10%
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chromium. In Equilibrium Calculator 1 a simple set of equilibrium conditions (temperature,
pressure, system size and composition) are used to find a carbon content where only the FCC A1
and BCC A2 phases are stable. The results from this preliminary calculation are displayed in
Table Renderer 1.

Equilibrium Calculator 2

In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the
condition that the numbers of moles of the BCC A2 phase should be 0.5. The final result is
displayed in Table Renderer 2. In this case, the final objective is to calculate the solidus
temperature of an Fe-Cr-C steel with 10% Cr and 0.01% C.
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Equilibrium Calculator 3

In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in Table
Renderer 3.
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Equilibrium Calculator 4

In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the condition
Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero moles, i.e. the
solidus temperature. The final result is displayed in Table Renderer 4.
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T_07: User-Defined Functions

This example shows how to implement user-defined functions.

A series of equilibria for an Fe-Cr-C alloy are calculated by varying temperature between 500
and 3000 K. In the configuration window of the Equilibrium Calculator under the Functions tab,
two identically meaning functions are defined, fraction solid and f solid, the values of which are
plotted against temperature in two Plot Renderer activities. Functions can be entered in terms
of QuantitiesQ1, Q2, Q3 and so forth, or by using the Thermo-Calc syntax.

PROJECT FILE INFORMATION

l Folder: Thermo-Calc

l File name: T_07_User_defined_functions.tcu
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PLOT RESULT

This plot example shows the result of the fraction solid function.
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T_08: Scheil and Equilibrium Solidification

This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and
under the Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast
diffusion in the liquid. The example uses the Scheil Calculator and adds a Plot and Table
Renderer.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_08_Scheil_and_equilibrium_solidification.tcu.

For other examples of using Scheil, see our website and YouTube channel:

Modified Austenitic Stainless Steel 18/8 Scheil Solidification Simulation

Applications to Welding and Joining with Bonus Scheil Example

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/VRL_SsKLca0
https://youtu.be/Q-527CeTrH0


Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 21 of 98

TABLE AND PLOT RESULTS

The plot compares the mole fraction of a solid vs temperature. The table provides the data,
which you can also export.
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TO SAVE THE TABLE

There are two ways to save the table.

Method 1

In the Results window, right click the table and select Save As...

Method 2

1. In the Project window, click the Table Renderer.

2. In the Configuration window, click Save table.
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T_09: Carbide Driving Force Heat Map

This is an example of using property grid calculations to plot the driving force for a carbide as a
function of two composition variables. With the property grid calculation type, a 2D grid is
generated from the two calculation axes. After the calculation is done, an equilibrium is
calculated in each grid point. A Plot Renderer connected to a property grid calculator plots the
z-axis property for each equilibrium as a function of the two calculation axes. The final plot can
be either a heat map or a contour plot.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_09_Heat_map_of_carbide_driving_force.tcu

PLOT RESULT
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Property Model Calculator Examples

The General models are available to all users. To run calculations with the Steel
models (martensite and pearlite) requires a valid maintenance license plus
licenses for both the TCFE9 and MOBFE4 databases.

PM_G_01: Phase Transition

The example uses the Property Model Calculator to predict the transition temperature to the
unwanted brittle Sigma phase. The example shows how the temperature is influenced by
changes to a steel alloy’s composition using the uncertainty calculation type and how to create
either a histogram or probability plot.

Phase Transition Model in the Thermo-Calc User Guide.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_01_Phase_Transition.tcu

l This example is included in the tutorial on our website and YouTube channel. Also see
the video introduction to this feature.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/l0OW8FNenZ4
https://youtu.be/l0OW8FNenZ4
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PLOT RESULTS

Histogram plot

Probability plot
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Experienced users can also create custom property models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.

PM_G_02: Coarsening and Interfacial Energy

The example uses the Property Model Calculator and both thermodynamic (FEDEMO) and
kinetic (MFEDEMO) demonstration steel databases. Using a grid calculation type it produces
these plots: a heat map, a contour plot and a cross plot with contour (where both the interfacial
energy and coarsening rate is shown). It also creates a property diagram to show the phase
fractions vs time and a 3D plot comparing the coarsening rate coefficient.

Coarsening Model and Interfacial Energy Model in the Thermo-Calc User Guide.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_02_Coarsening_and_Interfacial_energy.tcu

l This example is included in the tutorial on our website and our YouTube channel. Also
see the video introduction to this feature.

Plot Results

Coarsening rate coefficient (heat map)

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/ztjTpUJ7ljU
https://youtu.be/ztjTpUJ7ljU
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Coarsening rate coefficient (3D plot)

Two different rotation angles. When viewing in Thermo-Calc you can rotate the plot.
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Coarsening rate coefficient (contour plot)

Coarsening rate coefficient
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Coarsening rate coefficient and Interfacial energy (overlayed plots)

Phase fractions vs T (Property diagram)

Experienced users can also create custom property models for use with the
Property Model Calculator.
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Search for Property Model Calculator and Development Framework in the help.

PM_G_03: Driving Force and Interfacial Energy

The example uses the Property Model Calculator and a thermodynamic demonstration steel
database (FEDEMO). Using a grid calculation type it produces a contour plot comparing the
driving force and interfacial energy.

Driving Force Model and Interfacial Energy Model in the Thermo-Calc User Guide.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_03_Driving_force_and_Interfacial_energy.tcu

l See the video introduction to this feature.

https://youtu.be/kMUNrR2o0bk
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PLOT RESULT

A contour plot

Phase Fraction
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Experienced users can also create custom property models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.

PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4 databases.

The example uses the Property Model Calculator with the Martensite Fractions and
Martensite Temperaturesmodels.

The example shows how to calculate martensite fractions and martensite temperatures
(martensite start, Ms, and 90% transformation temperature M90). The alloy is first
intercritically annealed and then quenched. Austenite composition is determined by an
equilibrium calculation at the annealing temperature. Martensite fraction is calculated as a
function of temperature which the alloy is quenched to. The example also shows how Cr
content in the alloy influences Ms and M90 after intercritical annealing.

REFERENCE

Harris, William J, and Morris Cohen. 1949. “Stabilization Of The Austenite-Martensite
Transformation.” Transactions of the American Society for Metals, AIME 180: 447–70.

PROJECT FILE INFORMATION

l Folder: Property models >Steel

l File name: PM_Fe_01_Fe-Cr-C_martensite_intercritical_annealing.tcu

PLOT RESULT

Transformation curves
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Ms-Mf

PM_Fe_02: Fe-Mn Martensite Morphologies

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4 databases.

The example uses the Property Model Calculator with the Martensite Temperaturesmodel. It
shows the Ms temperatures of different types of martensites: lath, plate, and epsilon (hcp),
compared with experimental epsilon Ms values.
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PROJECT FILE INFORMATION

l Folder: Property Models>Steel

l File name: PM_Fe_02_Fe-Mn_martensite_morphologies.tcu

PLOT RESULT

PM_Fe_03: Fe-C-Mn Pearlite

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4 databases.

The example uses the Property Model Calculator with the Pearlite model.

The example shows how to calculate pearlite growth rate, lamellar spacing, and times of start
(2% transformation) and finish (98% transformation) as functions of isothermal heat treating
temperature in an Fe-0.69C-1.80Mn alloy (mass %). With "maximize growth rate" as the
"criterion", the model gives maximal growth rate and minimal lamellar spacing. With "optimal
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pearlite" as the "pearlite mode", the model optimizes partitioning of substitutional alloying
element(s) (Mn in this example) according to the "criterion", which realizes a smooth transition
between ortho-pearlite at high temperature and para-pearlite at low temperature.

REFERENCE

Razik, N.A, G.W. Lorimer, and N Ridley. 1974. “An Investigation of Manganese Partitioning
during the Austenite-Pearlite Transformation Using Analytical Electron Microscopy.” Acta
Metallurgica 22 (10): 1249–58. doi:10.1016/0001-6160(74)90138-2.

PROJECT FILE INFORMATION

l Folder: Property Models>Steel

l File name: PM_Fe_03_Fe-C-Mn_Pearlite.tcu

PLOT RESULT

Growth Rate



Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 37 of 98

Lamellar Spacing

TTT
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Diffusion Calculator Examples

Examples using up to three elements are available to all users. The other examples
require a Diffusion Module (DICTRA) license to calculate and plot results.

All examples use demonstration database packages included with your installation
no matter what licenses you have.

"Diffusion Calculator" in the Thermo-Calc User Guide

D_01 Homogenization of a Binary Fe-Ni Alloy

The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in a
planar domain. At this temperature the material is fully austenitic, i.e. the only phase present is
the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in Ni going
from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

This example is available as a video tutorial on our website and YouTube
channel. In previous versions of the software (prior to 2017b) it is example 19.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/H5xA3_uCHbc
https://youtu.be/H5xA3_uCHbc
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Composition of Ni vs Distance

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_01_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available
to all users. A version of the example is also available for Console Mode.

D_02 Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy

The moving phase boundary example simulates the growth of ferrite (bcc) into austenite (fcc).
The austenite is assumed to be initially homogeneous with the composition Fe-0.15 mass-% C.
The transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an
initially very thin ferrite (1 nm) is also present at the start of the simulation.

This example is available as a video tutorial on our website and YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/03cTmXS1AV8
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Position of interface vs time
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Composition profile C

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_02_Diffusion_Moving_Boundary.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available
to all users. A version of the example is also available for Console Mode.
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D_03 Evolution of an Fe-Cr-Ni Diffusion Couple

The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100
hour heat treatment at 1100° C (1373.15 K). Both end members of the diffusion couple are
duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and
austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid
point, i.e. the local phase fractions, phase compositions and so forth are obtained from an
equilibrium calculation with the local overall composition as a condition.

More details about the homogenization model for multiphase simulations can be found in
Larsson and Engström (2006)1. and Larsson and Höglund (2009)2. . Experimental data is from
Engström (1995)3. .

1. "A homogenization approach to diffusion simulations applied to α + γ Fe–Cr–Ni diffusion couples", Acta Mater., 54 (9), pp.
2431–2439.
2. "Multiphase diffusion simulations in 1D using the DICTRA homogenization model", Calphad, 33 (3), pp. 495–501.
3. "Interdiffusion in multiphase, Fe-Cr-Ni diffusion couples", Scand. J. Metall., 24(1), 12–20.
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Phase fraction of FCC

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_03_Diffusion_Multiphase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available
to all users. A version of the example is also available for Console Mode.

D_04 Fe-C Moving Boundary: Austenite to Ferrite

This example simulates the austenite to ferrite transformation in a Fe-0.01 mass% C steel
during continuous cooling. The simulation starts at a temperature where only austenite is
stable, ferrite nucleates and grows into the austenite during cooling in the two phase region.
Plots of thermal and carbon composition profiles are generated.
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Thermal profile
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Carbon composition profile

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_04_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu

This example is available to all users.
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D_05 γ/α/γ Diffusion couple of Fe-Ni-Cr alloys

This example demonstrates the evolution of a ternary Fe-Cr-Ni diffusion couple. A thin slice of
ferrite (α phase) (38%Cr,0%Ni) is clamped between two thicker slices of austenite (γ phase)
(27%Cr, 20%Ni). The assembly is subsequently heat treated at 1373 K.

This set up corresponds to diffusion couple in Kajihara, Lim, and Kikuchi (1993)1. . Also see
Kajihara and Kikuchi (1993)2. .

1. "Experimental Study on Dissolution of ALPHA Phase in GAMMA/ALPHA/GAMMA Diffusion Couples of the Fe-Cr-Ni System",
ISIJ Int., 33(4), 498–507.
2. "Numerical analysis of dissolution of α phase in γ/α/γ diffusion couples of the Fe-Cr-Ni system", Acta Metall. Mat., 41(7),
2045–2059.
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Interface Position
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Concentration profiles at 3600 s
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Concentration profiles at 36000 s
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Concentration profiles at 36 0000 s
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Concentration profiles at 3 600 000 s
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Diffusion paths

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_05_Diffusion_Fe_Ni_Cr_Moving_Boundary_Diffusion_Couple.tcu

D_06 Diffusion Through a Tube Wall

This is a simple example of diffusion through a tube wall . The tube material is an Fe-0.06Mn-
0.05C alloy. Two plots comparing distance to the U-fraction of manganese and composition of
carbon are generated to visualize the austenite region. A cylindrical geometry is used with
mixed zero flux and activity boundary conditions.

On the inside wall a carbon activity of 0.9 is maintained whereas on the outside the carbon
activity is very low. This example demonstrates the use of boundary conditions, advanced
plotting and tables.

This example is based on Console Mode exab6 (see in the Diffusion Module
(DICTRA) Console Mode Examples Guide). When in Console Mode, you can open
the example from Thermo-Calc (File → Examples Files → Diffusion Module).
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Composition of C vs Distance
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U-fraction of Mn vs Distance

Table Composition C vs Distance

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_06_Diffusion_Carburization_Tube.tcu
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D_07 Multiphase Carburization of a Ni-25Cr-0.0001C alloy

This example is about carburization of a Ni-25Cr-0.0001C alloy. In this case the M7C3 and
M3C2 carbides are entered as spheroid phases in an FCC_A1 matrix. It is similar to Graphical
Mode example D_06 except the default Simulation condition is automatically set to use the
Homogenization model.

The Isothermal calculation is run for 1000 hours at a temperature of 1123 K using the Mixed
zero flux and activity left boundary condition. Results are plotted using two Plot Renderers and
a Table Renderer.

This case is from Engström, Höglund, and Ågren (1994), "Computer simulation of diffusion in
multiphase systems", Met. Mat. Trans. A, 25(6), 1127–1134.

This example is based on Console Mode exd1b (see in the Diffusion Module
(DICTRA) Console Mode Examples Guide). When in Console Mode, you can open
the example from Thermo-Calc (File → Examples Files → Diffusion Module).

This example is available as a video tutorial on our website and YouTube channel.

Phase fraction vs distance

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/BiaJSiWdw4U
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Table of Composition profiles
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Composition of C vs Distance

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_07_Diffusion_Carburization_Multiphase.tcu
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Precipitation Calculator Examples

Examples that use up to three elements are available to all users. The other
examples require a Precipitation Module (TC-PRISMA) license to calculate and plot
results.

All examples use demonstration database packages included with your installation.
You can open the examples from the main menu: File → or Help → Examples Files.

Unless specified in tables for each example, all the numerical parameters are
assumed default values.

P_01: Isothermal Precipitation of Al3Sc

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.
The simulation results can be compared with experimental data collected from Marquis and
Seidman1. and Novotny and Ardell (2001)2. .

This example is available as a video tutorial on our website and YouTube channel.

System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

1.Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates in Al(Sc) Alloys.” Acta Materialia
49 (11): 1909–19.
2.Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” Materials Science &
Engineering, A: Structural Materials: Properties, Microstructure and Processing 318 (1–2): 144–54.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/U05n2y9oB_s
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Precipitate phase AL3SC

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy Calculated

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E7 seconds

Other

File name and location
Folder: Precipitation Module - TC-PRISMA

File name: P_01_Precipitation_Al-Sc_AL3SC.tcu

Plot Results

Mean radius
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P_02: Stable and Metastable Carbides - Isothermal

This example simulates the kinetics of precipitation of both stable and metastable
carbides from ferrite phase. It demonstrates that metastable carbides (cementite,
M7C3) may first emerge and then disappear and the stable phase (M23C6)
prevails.

This example uses the Equilibrium Calculator and a property diagram to determine how the
phases change with temperature. We are interested in the carbide precipitation at 1053K
where only the carbide M23C6 is stable according to the equilibrium calculation. The
Precipitation Calculator is used to do an isothermal calculation of the three phases (cementite,
M23C6 and M7C3) where cementite and M7C3 are metastable phases.

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show details to display this
setting)

1.0E-4 m

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K
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Simulation time 400 000 seconds

Other

File name and location

Folder: Precipitation Module - TC-PRISMA

File name: P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-
M23C6.tcu

Plot Results

Equilibrium Calculator: How the phases changewith temperature
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Precipitation Calculator: Volume fractions

P_03: Stable and Metastable Carbides - TTT Diagram

In this example, the kinetics of precipitation of both stable and metastable carbides
is calculated from the ferrite phase. It demonstrates that metastable carbides may
first emerge and then disappear and the stable phase prevails.

This example uses the Equilibrium Calculator and a property diagram to determine how the
phases change with temperature. Using this result, the Precipitation Calculator is used to do a
TTT (Time-Temperature-Transformation) diagram calculation of the three phases (cementite,
M23C6 and M7C3) at the grain boundaries.

For a TTT diagram calculation, select TTT diagram in Calculation Type, then enter Min, Max,
and Step of Tempeature, as well asMax annealing time. In Stop criterion, choose Volume
fraction of phase and enter the value.

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)
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Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show details to display this
setting)

1.0E-4 m

Precipitate Phase Data Parameters

Nucleation sites Grain boundaries

Interfacial energy
Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282
J/m2

Calculation Type (Precipitation Calculator)

Calculation type TTT diagram

Temperature 500° to 800° C with 25° C steps

Max. annealing time 1.0E8 seconds

Stop criteria Volume fraction of phase is set to 0.0001

Options > Numerical Parameters

No. of grid points over one order of magnitude
in radius

150

Max no. of grid points over one order of
magnitude in radius

200

Min no. of grid points over one order of
magnitude in radius

100

Other

File name and location Folder: Precipitation Module - TC-PRISMA
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File name: P_03_Precipitation_Fe-C-Cr_TTT_Cementite-
M7C3-M23C6.tcu

Plot Results

Equilibrium Calculator: How the phases changewith temperature
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Precipitation Calculator: TTT diagram

P_04: Precipitation of Iron Carbon Cementite

Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example is
based on Wert (1949)1. .

This example uses two Experimental File Reader activities with the Precipitation Calculator and
an isothermal calculation, to plot the volume fraction of the cementite phase.

System (System Definer)

Database package
Demo: Steels and Fe-alloys (FEDEMO and
MFEDEMO)

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.016C mass percent

Matrix phase BCC_A2

1.Wert, Charles A. 1949. “Precipitation from Solid Solutions of C and N in α-Iron.” Journal of Applied Physics 20 (10). AIP
Publishing: 943.
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Precipitate phase Cementite

Matrix Phase Data Parameters (Precipitation Calculator)

Grain aspect ratio (click Show details to display this
setting)

1.0

Dislocation density (click Show details to display this
setting)

1.5e11m-3

Precipitate Phase Parameters (Precipitation Calculator)

Nucleation sites Dislocations

Interfacial energy 0.24 J/m2

Growth rate model (click Show details) Advanced

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 102° C

Simulation time 600 000 seconds

Other

File name and location
Folder: Precipitation Module - TC-PRISMA

File name: P_04_Precipitation_Fe-C_Cemetite.tcu
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Plot Results

Volume Fraction

P_05: Precipitation of γ’ in Ni Superalloys - Isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase. The
simulation results can be compared with experimental data collected from
Sudbrack et al. (2008)1. .

This example uses three Experimental File Reader activities with the Precipitation Calculator. It
does an isothermal calculation to plot the volume fraction, mean radius and number density of
the cementite phase.

DIS_FCC_A1 needs to be selected on the System Definer. See Selecting the
Disordered Phase as a Matrix Phase for details.

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

1. Sudbrack, Chantal K., Tiffany D. Ziebell, Ronald D. Noebe, and David N. Seidman. 2008. “Effects of a Tungsten Addition on the
Morphological Evolution, Spatial Correlations and Temporal Evolution of a Model Ni–Al–Cr Superalloy.” Acta Materialia 56 (3):
448–63.
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Elements Ni, Al Cr

Conditions (Precipitation Calculator)

Composition Ni-9.8Al-8.3Cr Mole percent

Matrix phase DIS-FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.012 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 800° C

Simulation time 1 000 000 seconds

Other

File name and location

Folder: Precipitation Module - TC-PRISMA

File name: P_05_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_
prime.tcu
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Plot Results

Volume Fraction

Number Density
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Mean Radius

P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase in Ni-
8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation
results can be compared with experimental results from Rojhirunsakool et al.
(2013)1. .

When you run (Perform) this example, it takes about 10 minutes for the
calculations to complete.

In these examples a linear, continuously cooling condition is set up. This is done on the
Precipitation Calculator settings window in the Calculation Type section:

1. Select a Non-Isothermal.

2. Select a Temperature Unit and Time Unit from the lists.

3. Click Thermal Profile, where Time-Temperature profile points are entered to describe
the stepwise heat treatment schedule with linear segments. Up to 999 rows of data

1. Rojhirunsakool, Tanaporn, S. Meher, J. Y. Hwang, S. Nag, J. Tiley, and Rajarshi Banerjee. 2013. “Influence of Composition on
Monomodal versus Multimodal Γ′ Precipitation in Ni–Al–Cr Alloys.” Journal of Materials Science 48 (2): 825–31.
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points can be entered.

In these examples two rows of data points are needed for starting time 0s and
temperature 1150° C, as well as end time 3300s and temperature 380° C.

4. Click the Plot Renderer node to select the Separate multimodal PSD check box.

Plotting the size distribution from the final simulation time of 3300 seconds, you can see
there are several peaks, although these are not completely separated. As above, select
the Separate multimodal PSD check box to separate the peaks.

5. Adjust the Valley depth ratio setting to 0.05 to separate into two peaks as shown in the
Ni-10Al-10Cr plot example. You can experiment with this setting to see how the size
distribution evolves with time, for example, try entering several values as plot times 400
600 3300.

DIS_FCC_A1 needs to be selected on the System Definer. See Selecting the
Disordered Phase as a Matrix Phase for details.

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent

Matrix phase DIS_FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility enhancement prefactor (click
Show details to display this setting)

5.0

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk
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Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Non-isothermal

Temperature unit Celsius

Time unit Seconds

Simulation time (Ni-8Al-8Cr) 1470 s

Simulation time (Ni-10Al-10Cr) 3300 s

Multimodal PSD (Plot Renderer)

Separate multimodal PSD for 8Al-8Cr
The Valley depth ratio is set to 0.05 for both plots. The number of
Points is increased to 200 for an average radius plot.

Separate multimodal PSD for 10Al-10Cr The Valley depth ratio is set to 0.18 for both plots.

Other

File name and location

Folder: Precipitation Module - TC-PRISMA

File name: P_06_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-
Gamma_prime.tcu



Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 73 of 98

Plot Results

Mean Radius Ni-8Al-8Cr

Mean Radius Ni-10Al-10CR
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Size Distribution (PSD) Ni-8Al-8Cr

Size Distribution (PSD) Ni-10Al-10Cr
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P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr γ-γ’

In this example, a Continuous Cooling Transformation (CCT) diagram for a Ni-10Al-10Cr γ-γ’
alloy is calculated and plotted with superimposition of the cooling rate values.

This example is available as a video tutorial on our website and YouTube channel.

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10Al-10Cr Mole percent

Matrix phase DIS_FCC_A1

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type CCT Diagram

Temperature Min to Max 500 to 1200 Kelvin

Cooling rate(s) .01 .1 1 10 100 K/s

Stop criteria Volume fraction of phase 1.0E-4

Other

File name and location
Folder: Precipitation Module - TC-PRISMA

File name: P_07_Precipitation_Ni-Al-Cr_CCT_Gamma-Gamma_prime.tcu

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/0q3iNyOKV1k
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Plot and Table Results

P_08: Precipitation of Cu-Ti CU4TI with Assumptions of Sphere and Needle
Morphologies

In this isothermal calculation example, the precipitation of Cu4Ti phase in a Cu-Ti binary alloy is
calculated. To make a comparison, two separate simulations are performed, one assuming
spherical morphology without elastic strain energy, and the other assuming needle morphology
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whose shape, determined by competition between interfacial energy and elastic strain energy,
is changed during the simulation. The transformation strain is obtained from Borchers1. . The
results are compared with experiment results from Kampmann et al2. .

This example takes a few minutes to run.

To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Needle nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when you
click Show details.

Precipitation Morphology

System (System Definer)

Database package Demo: Copper-based alloys (CUDEMO and MCUDEMO)

Elements Cu, Ti

Sphere and Needle Conditions (Precipitation Calculator)

Composition Cu-1.9Ti Mole percent

Matrix phase FCC_L12

1. Borchers C. 1999. "Catastrophic Nucleation during Decomposition of Cu-0.9at.%Ti." Phil. Mag. A 79(3):537-547
2. Kampmann R., Eckerlebe H., and Wagner R. 1987. "Precipitation Kinetics in Metastab le Solid Solutions - Theoretical
Considerations and Application to Cu-Ti Alloys." Mat. Res. Soc. Symp. Proc. 57: 525-542.
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Precipitate phase CU4TI1

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility enhancement
prefactor (click Show details to
display this setting)

100

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default

Morphology (click Show details
to display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the
default.

For the Needle node (renamed from Precipitation Calculator), Needle is
selected.

Transformation strain (click
Show details to display this
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the
default.

For the Needlenode (renamed from Precipitation Calculator), User defined
is selected. In this example, the following settings are defined:

l ε11 and ε22 are set to 0.022

l ε33 is set to 0.003

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 10,000 seconds

Datasets (Experimental File Reader)

Borchers Mean radius vs Time
and Borchers Number density
vs Time

Data sets included with this example and imported to two Experimental
File Readers. These data sets are used for the Mean Radius and Number
Density plots, respectively.

Other

File name and location Folder: Precipitation Module - TC-PRISMA
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File name: P_08_Precipitation_Cu-Ti_CU4TI1_Sphere_Needle.tcu

Plot Results

Mean Aspect Ratio
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Number Density
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PSD and ASD
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Mean Radius

P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid
Morphologies

In this isothermal calculation example, the precipitation of Al3Sc phase from FCC_A1 matrix
phase in an Al-Sc binary alloy is simulated. To make a comparison, two separate calculations
are performed, one assuming spherical morphology without elastic strain energy, and the other
assuming cuboid morphology whose shape is determined by competition between interfacial
energy and elastic strain energy. The simulation results are compared with experimental data
collected from Marquis and Seidman1. and Novotny and Ardell (2001)2. . In addition, mean cubic
factor and cubic factor distribution are also plotted for cuboid shape to illustrate the spherical-
cuboidal transition during precipitation.

1.Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates in Al(Sc) Alloys.” Acta Materialia
49 (11): 1909–19.
2.Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” Materials Science &
Engineering, A: Structural Materials: Properties, Microstructure and Processing 318 (1–2): 144–54.
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To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Cuboid nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when you
click Show details. See P_08 for an example of this.

This example is available as a video tutorial on our website and YouTube channel.

Precipitation Morphology

System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Sphere and Cuboid Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Precipitate phase AL3SC

Matrix Phase Data Parameters (Precipitation Calculator)

Elastic properties
(click Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), the default, Disregard
is kept.

For the Cuboid node (renamed from Precipitation Calculator), choose Cubic. Then
enter the elastic constants accordingly. Default elastic constants are given based on
the major element of the alloy system. In this example that is

l c11 is 108.2 GPa

l c12 is 61.3 GPa

l c44 is 28.5 GPa

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default

Morphology (click
Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

For the Cuboid node (renamed from Precipitation Calculator), Cuboid is selected.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/PdtXLFFbqJA
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Transformation strain
(click Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

For the Cuboid node (renamed from Precipitation Calculator), Calculate from molar
volume is selected to obtain a purely dilatational strain.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E9 seconds

Datasets (Experimental File Reader)

Dataset 1 and Dataset
2

Data sets included with this example and imported to one Experimental File Reader.
It is used for the Mean Radius plot.

Other

File name and
location

Folder: Precipitation Module - TC-PRISMA

File name: P_09_Precipitation_Al-Sc_AL3SC_Sphere_Cuboid.tcu
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Plot Results

Mean Radius



Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 86 of 98

PSD
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Mean Radius and Cubic Factor
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PSD and Cubic Factor

P_10: Initial Particle Size Distribution of Fe-Cr-C

This example demonstrates the effect of initial particle size distribution of the precipitate
phases on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate and
compare carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy. Three
carbides, CEMENTITE, M23C6 and M7C3, are included in the calculations for competitive
precipitations, and the precipitation kinetics are compared with or without initial particle size
distribution.

The example illustrates the use of the particle size distribution setting. You can import data
from a spreadsheet or text file (.xls, .xlsx, .csv or .txt formats are acceptable). The Preexisting
Particle Size Distribution window shown below, provides a graphical representation of the
radius versus corresponding frequencies.
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System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase
BCC_A2

All other defaults are kept.

Precipitate phases CEMENTITE, M23C6 and M7C3

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites
Grain boundaries (all calculations): Calculated from the matrix settings with a
wetting angle of 90°

Interfacial energy
User-defined function f(r,T) (all calculations):

l CEMENTITE: 0.167 J/m2
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l M23C6 0.252 J/m2

l M7C3 0.282 J/m2

Preexisting size
distribution (click Show
details to display this
setting)

For the Precipitation Calculator including particle size distribution, and for all
precipitate phases, this check box is selected.

For each precipitate phase (CEMENTITE, M23C6 and M7C3), click Edit particle
size distribution to make changes to the parameters. A window opens with a
graphical representation of the radius vs number density.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

Other

File name and location
Folder: Precipitation Module - TC-PRISMA

File name: P_10_Precipitation_Initial_PSD_FeCrC.tcu
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Plot Results

Volume Fraction with Initial Particle Size Distribution
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Volume Fraction with No Initial Particle Size Distribution

P_11: Interfacial Energy Function

In some cases, interfacial energy may be a function of temperature and/or particle radius. This
example uses four Precipitation Calculators at four temperature points in 30 K increments: 673
K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the mean radius of an Al-
0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate phase with bulk
nucleation sites and user-defined interfacial energy function. The user defined interfacial
energy function uses an error function to set a smooth transition of the interfacial energy from
0.065 J/m2 to 0.085 J/m2 for particle radii below and above 1e-8m and 5e-8m, respectively.

A dataset based on Iwamura and Miura (1. ) data is compared with the calculated results.

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

1. Iwamura, S, and Y Miura. 2004. “Loss in Coherency and Coarsening Behavior of Al3Sc Precipitates.” Acta Materialia 52 (3):
591–600.
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Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.12Sc Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate phase

AL3SC

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf((r-
3e-8)/1e-8 J/m2)

Calculation Type (Precipitation Calculator)

Calculation type Isothermal (all calculations)

Temperature Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time 1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)

Wamura 2004
(Dataset 1)

Data set included with this example and imported to one Experimental File Reader.

Other

File name and
location

Folder: Precipitation Module - TC-PRISMA

File name: P_11_Interfacial_energy_function.tcu



Thermo-Calc Graphical Mode Examples Guide

About the Graphical Mode Examples ǀ 94 of 98

Plot Results

Mean Radius

P_11: Interfacial Energy Function

In some cases, interfacial energy may be a function of temperature and/or particle radius. This
example uses four Precipitation Calculators at four temperature points in 30 K increments: 673
K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the mean radius of an Al-
0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate phase with bulk
nucleation sites and user-defined interfacial energy function. The user defined interfacial
energy function uses an error function to set a smooth transition of the interfacial energy from
0.065 J/m2 to 0.085 J/m2 for particle radii below and above 1e-8m and 5e-8m, respectively.

A dataset based on Iwamura and Miura (1. ) data is compared with the calculated results.

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

1. Iwamura, S, and Y Miura. 2004. “Loss in Coherency and Coarsening Behavior of Al3Sc Precipitates.” Acta Materialia 52 (3):
591–600.
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Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.12Sc Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate phase

AL3SC

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf((r-
3e-8)/1e-8 J/m2)

Calculation Type (Precipitation Calculator)

Calculation type Isothermal (all calculations)

Temperature Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time 1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)

Wamura 2004
(Dataset 1)

Data set included with this example and imported to one Experimental File Reader.

Other

File name and
location

Folder: Precipitation Module - TC-PRISMA

File name: P_11_Interfacial_energy_function.tcu
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P_12: Comparing Growth Rate Models for an Al-Zr System

This example compares the Simplified, General and Advanced growth rate models for an Al-Zr
system. The resulting plot compares the mean radius of the spheres for each AL3ZR_D023
precipitate phase calculated for each type of growth rate model.

For more details, see the theory described in Growth.

The example takes several minutes to run.

All models treat a spherical particle (precipitate) of stoichiometric composition or with
negligible atomic diffusivity. Local equilibrium at the precipitate-matrix interface is assumed.

When you use the Advancedmodel, the velocity of a moving phase interface and the operating
tie-line are solved together from flux-balance equations. This model can treat both high
supersaturation and cross diffusion rigorously. It can also capture the transition between NPLE
(non-partitioning local equilibrium) and PLE (partitioning local equilibrium) without any ad hoc
treatment.
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The Simplifiedmodel is based on the quasi-steady state diffusion approximation, and estimates
solute partitioning with matrix composition and nuclei composition instead of time-consuming
stepwise tie-line calculations. It also neglects cross diffusion for simplicity.

The General model can be considered the same theoretical approximation as, but an
improvement over, the Simplifiedmodel, with cross-diffusion terms taken into account, as well
as adjustment of Gibbs-Thomson effect and effective diffusivity implemented.

System (System Definer)

Database
package

Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Zr

Conditions (Precipitation Calculator)

Composition Al-0.2Zr Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate
phase

AL3ZR_D023

Click Show details to select the Growth rate model (Simplified, Advanced and General).
All other defaults are kept.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 425 Celsius

Simulation time 400 hours

Datasets (Experimental File Reader)

2008 Knipling Data set included with this example and imported to one Experimental File Reader.
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